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WEB PAGE DEVELOPMENT

Terms for the web page:

Browser:  A utility program that can accept and display information from any computer from any
place on the Internet regardless of the platforms.  Two most popular browsers for the web are the
Netscape Communicator and the Microsoft Internet Explorer.

Hot Links (or hyperlinks) :  Hot spots such as text or images that allow users to click and move
between data.

HTML :  Hypertext Markup Language.  A computer language that build up the web pages for the
World Wide Web (WWW).

HTTP :  Hypertext Transfer Protocol.  A method to transfer information on the World Wide Web
and to ensure the files to be readable by browsers.

URL :  Uniform resource locator.  The name for addresses used on the web.

What are we learning:

Though there are many commercial and shareware software titles that allow users to create web
pages, it is essential that users should understand the meaning of some basic source codes of the
HTML language in order to maintain and fix it.  We are learning the basics about the web page
development starting from the scratch.  We will learn the professional ways of building up a web
page and all the essential elements of a web page.  We will also learn some other approaches to
create quick web pages.

Create a web page with an editor and a web browser:

Follow the procedures below to create a web page.

• Load an editor such as Simpletext or Notepad.
• Load a browser such as Netscape Communicator or MS Internet Explorer.
• Move the program windows around so that they will overlap with each other for easy

switching.
• Create a text file with the editor.
• Open the file in the browser to view the result.
• Modify the text file.
• Reload the file in the browser.

Exercise: Creating a simple web page using Simpletext and Netscape

Move between Simpletext and Netscape.
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a. Load both Simpletext and Netscape Communicator.
** Resize the program windows so that they are not fully overlapping against each other.  By
doing so, you can easily switch between the editor and the browser.

b. Switch to the Simpletext program from the Application menu.

c. Enter the following text for a base page:

<html>
<head>
</head>
<body>
</body>
</html>

d. Save the file as “htmlbase” onto the desktop.

e. Switch to Netscape by choosing the Netscape from the Application menu or click at the
Netscape Window.

f. Select Open file in Browser from File menu and open “htmlbase”.  You should see a blank web
browser page.

g. Add more information to the web page.

h. Switch to the Simpletext and enter the following information between <body> and </body>.

My most favorite activities: <p>
<ol>
<li> Watch movies
<li> Computer games
<li>Swimming
</ol>

i. Switch to Netscape and click the Reload button.

j. Add a link to the page.  Add the following to the body of your html source codes.

k. Switch to the Simpletext and enter the following text.

    <a href=“http://www.tcnj.edu”> Click here to visit the College of New Jersey. </a>

l. Switch to Netscape and click the Reload button.
m. Check and try out the link.

Note:
You do not have to get on-line in order to do this exercise.
If by accident the Netscape program window was closed, simply go to the File menu and open a
new Navigator window.
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Base page of a web page:

Enter the following into a text file as your web page's base.

<HTML>
<HEAD>
</HEAD>
<BODY>
</BODY>
</HTML>

Save this file under your name, e.g., JohnPage.htm.

Learning about the basic HTML codes:

In between <HEAD> and </HEAD>, enter the following codes.
<TITLE>Wonder Works</TITLE>

Notes:
The web page source codes do not have the WYSIWYG (What you see is what you get) feature.
The commands in the web source codes do not need to be case-sensitive.  The URLs need to be
case-sensitive.

Exercise:

What is URL?

What is the function of a web browser?

What do these following codes do?
<BR>
<UL>
<OL>
<P>
<HR>
<H1>
<B>

How can you align elements centered on a web page?

Can you fix the following codes:

1) <a href=http:///www.microsoft.com. Microsoft Corp. </a>

2) <img scr=“flower .gif>

3) <UL> My favorite activities: </UL>
<UL> Swimming </UL>
<UL> Watching movie </UL> <BR>
<UL> Going fishing </UL>
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Task:  My favorite things to do

Enter the source codes as below and show it with Netscape.

<html>

<head>
<Title> My favorite things </title>

</head>

<body>
       <h1> My name is *** put down your name ***.  </h1><p>
         <h2> My most favorite things include the following: </h2><p>

<h4>
      <ul>
           <li> Watch movie.

            <li> Vacation.
            <li> Sports.

           <li> Eat out.
       </ul>
</h4>
<h4>
      <ol>
            <li> Watch movie.
            <li> Vacation.
            <li> Sports.
            <li> Eat out.
       </ol>
</h4>
      <hr><p>
     <center>

I plan to take every moment to enjoy my life.
     </center>

</body>
</html>

Tasks:

• Save a copy of the file to your disk and print out your screen as well as the source codes.
• Create an outline with information about your favorite web sites.  Make them clickable.

Learn by viewing other people's web page source codes

• To view the source codes of the current web page, select Page Source from the View menu.
• To save the source codes of the current web page, select Save As from the File menu and

select the Source format.
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On-line HTML source code tutorial

The following web site provides detailed information about HTML source codes and web page
development.

http://159.91.15.227/wwwinfo.html

Web page design:

Do's and don'ts:

• Organize the layout as an easy to see the most important information at the first
screen.

• Don't include graphics that are not related.
• Don't use heavy color or images as the background.
• Do observe the copyright issues and don't copy the copyrighted contents.

What are desirable to put on the personal web pages:

Some ideas about what to put onto the web.

• Biological information/ expertise/ pictures/ animation/ pre-recorded speech
• Course information/ Syllabi/ Assignments (from an instructor)
• Professional development: publications, presentations, and workshops
• Grants and projects
• Philosophy/ theory and practice/ vision
• Complete curriculum vita
• Announcements
• Favorite web sites related to your areas of expertise
• Collection of quotations
• Accomplishments
• Personal interests

What could a teacher's page look like?

• School logo or the teachers' logo.
• Course information.
• Neat graphics to match the contents.
• Instructional materials.
• Stories, rhymes, tongue twisters, riddles, and brain teasers.
• Schedules.
• Newsletter/ communications.
• Favorite sites
• Assignments
• School collaboration
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Do’s and Don’ts in web page development

1. Don’t work directly from the floppy disk, especially from a PC disk in a Mac drive.
• Copy all relevant files from the floppy disk to the desktop.

• Work on files on the desktop or in a folder.

• When you are all done with the work, copy files from the desktop to the floppy disk.

2. Do avoid spaces in file name.  Follow the DOS file name default, i.e., 8-letter name plus 3-letter
extension.

3. Do add extensions to graphics files, for example, flower.jpg, car.gif.

4. Do put all the relevant files together in the same place.  (For example, put all the html
documents and graphics files on the desktop or in a folder.  Don’t put one file in one folder and
another in a different folder.)

5. Do follow the code format exactly.  If the web page does not show the results as expected,
check to see if the source codes have the complete format, such as <h1> ...</h1>,
<table>...</table>.

6. Do load the html file directly into the browser.  Select Open file in Browser from File menu in
Netscape.

7. Don’t interweave codes across each other.   The following is a bad code example.
<UL> <OL></UL><h1></OL></h1>

Trouble-shooting your HTML bugs

When things don’t work, check the following items:

1. Is your text editor and browser up and running?

2. Is the format for the html codes correct?

3. Are you running from the floppy disk or the desktop?

4. Did you drag a copy of your web page files from the floppy disk to the desktop while holding
down the option key?

5. Have you saved and updated the html file before you reload the web browser?

6. Do you have more than one version of the file running at the same time?

7. Are you running the correct html document?

8. Do you have everything put in the same location?

9. Is the graphics file name exactly the same as specified in your html document?

10. Do you have codes mixed together?
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Add a clickable element to the web page:

Either text or graphics can become clickable elements which can be linked to other files or sites.

To link an element to another file or site, use anchor.  The format of the anchor is as follows.

<A HREF="source of the file">Graphic or text for linking </A>

How can I link a text to a different location within my document?

In order to link a text to a different location within the same document, you will need two things.
Link fragment(<A HREF="#name">) and anchor name (<A NAME="name">)within the
document.

For example:

In the table of contents:  <A HREF="#intro"> Introduction to computers</A>
In the text that starts the introduction:  <A NAME="intro"> Introduction to computers

Exercises:
• Break a long document into several smaller pieces and create a link between them.
• Create a table of contents for document and link the items in the TOC to a designated

area in the document.

Add a nice touch with graphics to the web page:

Sources of graphics
Scanning
Using digital camera
Using camcorder
Locating clip art graphics and images

Graphics tasks:

Locate and retrieve free clip art graphics from the Internet.
http://www.clipart.com/

Add a graphic to the web.
<img src=“file_name.jpg”>

Align a graphic to the right.
<img src=“file_name.jpg” align=“right”>



8

Control the image size.
<img src=“file_name.jpg” height= 150 width=200>

Convert graphics

Two widely accepted web graphics formats for PC and Mac:
GIF: Graphics Interchange Format, a widely used format by CompuServe.
JPEG: Joint photographic Expert Group developed this format for highly compressed
image result.
(Use extension to represent the file formats:  e.g., Mypic.gif or Mypic.jpg)

Use the graphics converter, such as GifConverter.
Convert a PICT picture into a GIF or JPEG format file.

• Use Simpletext and GIFConverter.

• Select a portion of graphics in Simpletext and copy it into the clipboard.

• Paste the copied graphic into a new GIFConverter document and save it as a GIF or

JPEG file.

Background:

Make a graphic as the web page background.
<body background=“file_name.jpg”>

Find the background color codes.
http://www.otn.com/iics/la/sigs/webspinr/colors.htm
http://hyperarchive.lcs.mit.edu/HyperArchive/Archive/text/html/html-color-picker-
203.hqx

Tasks:

• Create an image for the background.
• Add color or image as the background.

Link a picture to a site.

<a href=“http://www.tcnj.edu”> <img src=“tcnj.gif”> </a>
(The TCNJ logo will be linked to the TCNJ web site.)

Note:  When creating a web page, make sure all the related documents are placed in the same location,
under the same folder.  Otherwise, some elements for the web page might not show.

Graphics assignment tasks:

1. Create a web page with a good background.

2. Include at least two graphics downloaded from the Internet.

3. Include at least one clickable graphic which links to a remote site.
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Create a table for the web

An example:

Differences between human beings and computers:

Human flexible slow emotional
Computer rigid fast indifferent

<BODY>
Differences between human beings and
computers:<P>

<TABLE>
<TR>

<TD>
Human

</TD>
<TD>

flexible
</TD>
<TD>

slow
</TD>
<TD>

emotional
</TD>

</TR>
<TR>

<TD>
Computers

</TD>
<TD>

rigid
</TD>
<TD>

fast
</TD>
<TD>

indifferent
</TD>

</TR>
</TABLE>
</BODY>

Commands:

<TABLE> ... <TABLE> defines a table.

<TR> ... </TR> defines table row.

<TD> ... </TD> defines table data.

Extra commands and parameters:

**  To draw borders and define cell
spacing:

<Table cellpadding= 2 cellspacing= 2
border=5> ..... </Table>

** To define the width of a table.

a. With percentage of the screen page
width.
<Table width=100%> ... </Table>

b. With percentage of the table width:
<TD width=30%> ... </TD>

** Graphics can be inserted into table
cells.
** Table can be used to design a nice
web page layout.
** When two elements from two table
data contain varied sizes, you may align
the items to the "top", "bottom",
"middle" or "baseline".

<TD valign="top"> ... </TD>
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Other multimedia elements:
Movies: QuickTime movies and AVI movies
Animation

Create a two-frame web page

Realize your web page- make it happen:

How can I put the web page onto my web space on the Unix?

Where is your web address on the Unix server?
Use your Unix account for your address as below.

http://www.tcnj.edu/~login_name

Create a web folder on the Unix server:
Log into the Unix (launch NCSA Telnet to Beast).
Enter the command wwwsetup at the Beast prompt.
(You need to do this only once.  This command will set up a “www”
directory on your web space.)

Use Fetch or other ftp programs to put all the documents into your web
space on the server.

Move a  file into the www folder by clicking at the Put File button.
Select the file and click Open.
Choose Raw format for the graphics files, and choose Text format for the
HTML document.
The main file should be named as index.html (in lower case).

Change mode to make all the files publicly accessible.
Switch to NCSA Telnet to Beast.
At the Beast prompt, enter

cd www  (to get into the www sub-directory)
chmod 755  *.*
(*.* meaning all the files)

How can I update my web page?

Make revision directly from the (Unix) Beast:
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Use Telnet to Beast to update.
At the Beast prompt, enter edit index.html.
Move the cursor with the arrow keys (not mouse) to the desired spot.
Insert or delete text for necessary revision.
Press control-x to exit the editor, press y to save the document, and press
return.
Switch to the Netscape to view the results of the change.

Switch between the Beast and PCs (or Macs):
Edit the file with NotePad (or Simpletext) from a PC (or a Mac).
Use FTP (or Fetch) program to upload the file to the server to overwrite
the original file in the web server.
To add more graphics, launch FTP or Fetch to upload.

Switch between Macs and PCs:
After you have created a text document for html and saved it on a Mac
desktop, you can copy it to a PC formatted disk (by dragging the file icon
to the PC disk icon).
When you launch Netscape on the Windows 3.1 or Windows 95, you can
open the file in the browser and view the web page.
You can also run the NotePad program which is in the Accessories folder.

Other approaches to create web pages:

Using commercial web page development tools
Use Claris Home Page
Use Visual page
Use the Netscape Composer

Use Application programs to convert web pages.

Create a document in Microsoft Word or ClarisWorks.
Save the document as an HTML document.

More Do's and Don'ts:

** Don't save the Netscape page over the html document.
** You need to have all the source files available at the same place in order to show the
web pages.
** Do find other people's source codes.

Tips and tricks:
Add comments which will not be executed in a web document:  (Useful for testing the
web page.)

<!--       Here comes the comment.     -->
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To create an indentation for the entire paragraph as long quote or citation, use the
command blockquote.

 <blockquote> .... </blockquote>

Create a non-breakable space using &nbsp;  .
If you try to add a few blank lines, you can use a non-breakable space (&nbsp;)

plus <br>.

Font size:  <Font size=value>
The default font size is 3 and a valid range is 1-7.
Use + or - to define the size, for example, <Font size=+2> text goes here! </font>.

Control the horizontal ruler:
Define thickness of the horizontal ruler:  <HR size= number>
Define width of the horizontal ruler:

<HR width=number (in pixels)>  or <HR width=percentage>
Align HR:  <HR align="right">

To download or upload files between the web directory in your Unix account and your
floppy disk:

Use the Fetch or FTP (for Windows) program.
Host= beast.tcnj.edu.
Enter your User ID and password.
Enter "www" for the Directory.
Use Get Files to download files.  Use Put Files to upload files.

To add a link to e-mail:  Use mailto

Review tasks:

1.  Use the table commands to create a simple table with one row and two data.   (The
two data are a graphic (tcnj.gif) and a text line--"Click here to see the College of New
Jersey.)  Both data should  be vertically centered.

2.  The following codes for a list contain bugs.  Identify the bugs by line numbers and
provide the revised codes on the lines.

Line 1:  <body background=tcnj.gif>
line 2: <ul> My hobbies </ul>
line 3: <ul> Collecting stamps </ul>
line 4: <ul> Listening to classic music </ul>
line 5: <ul> Fishing </ul> <body>
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Quiz tasks: Name: ___________________________________________

Write down HTML codes to make the following tasks work.

1.  Create a numbered list as below.  Make each list clickable and link to an equivalent
site.

My favorite sites:
1. Yahoo
2. Microsoft
3. Disney

(The site addresses are "http://www.yahoo.com", "http://www.microsoft.com", and
"http://www.disney.com".)

2.  Display the School of Education logo (Logo.GIF).  Make the picture linkable to the
following site:  "http://www.tcnj.edu/~educat/".

3.  Create a meeting schedule in a table as below.  (Write on the back on this sheet.)

Meeting schedule:
April 1 3:30 pm Fundraising

May 2 9:00 am Recruitment

June 3 2:00 pm Summer session
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Exercise:  Which code will you use for the following situations?

1. To add a graphic (called "mypic.gif") to the web page:

2. Turn the following items into a bullet list:  (CPU, Memory chips, Hard disk, CD-ROM
drive)

3. Make the word "Microsoft" linkable and clickable to connect to the Microsoft web site
(http://www.microsoft.com).

4. Draw a line before and after your full name.  Center your name and make your first
name flash.

5. Grab the graphic "tcnj.gif" from the Web.  Create a web page include the same graphic
(tcnj.gif) three times.   Make the graphics with size of 150x150.  No two graphics are
allowed on the same row.  The first graphic should be centered, the second aligned left,
and the third aligned right.

6. Make the graphics in item 5 clickable and linked to the tcnj web site
(http://www.tcnj.edu).

7. Convert your own picture and use it as the web page background.

8.  Create a table as in the following:

Total cost table:
Personnel Cost per hour Time spent
Supervisor 120 50 min.
Auditor 100 30 min.
Employee 55 120 min.
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Web page challenge:

As a web master, your boss assigned you a mission to design and develop a home page
for him.  The specifications include the following:

1.  Put a logo of the department hanging on the upper right of the page.

2.  Add some animations to the web.
(Go to a search engine to look for some animation graphics.)

3.  Include a table for daily class schedule.
Daily class schedule:

8:40 Getting ready for the class
9:00 Announcements
9:30 First and second classes
11:20 Lunch break
12:10 Third and fourth classes
2:00 Recess
2:20 Fifth class
3:05 School release
3:30 Staff meeting

4.  Generate a list of a few most favorite educational web sites.
(You can visit many education sites and come up with your own list.)

5.  Add a color background.

6.  Separate text or graphics items with a horizontal lines as needed.

7.  Add some text with different sizes and colors.

8.  Add your boss' name to the title.

9.  Add a clickable graphic to search for people.  By clicking at the picture, it links to the
web page of http://www.switchboard.com/.

10.  Find out some of the sites related to teaching math, science, social studies, or early
childhood (choose only one subject).  Group the sites for the same subject and make them
clickable.

11.  Find out the sites for lesson plans related to teaching math, science, social studies, or
early childhood (choose only one subject).  Group the sites for the same subject and make
them clickable.
.
12. Add your boss' picture (150*150) with a table border frame (with width=7)
surrounding it.  Center the picture.
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Quiz for Web page development

True or False: (Mark each true statement with a T, and each false statement with an F.)
______ 1.  The following codes make the text "Yahoo!" clickable on the web page, and once being clicked
at, it would link directly to the Yahoo site (if it is properly online).

<a href=http://www.yahoo.com> Yahoo! </a>

______ 2.  When you double-click at the Netscape program icon to launch the program, a web browser
screen will appear to show the initial home page.

______ 3.  To create and display a web page, I will need a text editor and a web browser.

______ 4.  We can display a web page by opening  a text file in a web browser even if we are not online.

______ 5.  To display a web page, we need to create codes with http language.

______ 6.  To force a line down on a web page, you will need to press an enter key in the source code.

______ 7.  The <UL> ... </UL>  will display bullet lists.

______ 8.  To draw a horizontal line, use the code <HR> ... </HR>.

______ 9.  The web page is flexible and will take almost all the graphics formats.

______ 10.  The URL on a web page is case-sensitive.

______ 11.  There may be up to five levels of headings from <h1> to <h5> in the source codes.

______ 12.  To move files between your personal computer and the Unix server, a ftp program is needed.
Telnet is one typical example of such a program.

______ 13.  A few HTML codes do not need ending codes, for example, <p>, <br>, <li>, and <td>.

______ 14.  To make some text flash, use the HTML codes <flash> ... </flash>.

______ 15.  To convert a graphics into JPEG or GIF format using GIFConverter, take the following steps:
a. Load the desired graphic with the original graphics program.
b. Select a portion of the graphic screen (using mouse).
c. Copy the selected portion into computer memory.
d. Quit the original graphics program and load the GIFConverter program.
e. Create a new graphics document.
f. Paste the graphic onto the screen.
g. Save the document as JPEG or GIF format.

______ 16.  GIF graphics are of better quality than the JPEG graphics.

______ 17.  If an application program is allocated with insufficient memory, it might refuse to copy and
paste a portion of the screen within the program.

______ 18.  To increase the memory allocation for an application, make sure the application is not in use.
Select the program icon and select Get info from the File menu and increase the number of the preferred
size for memory.

______ 19.  To find who is currently online, use the Finger command in Unix.

______ 20.  When developing web pages, all source files must be kept in the same place (disk and folder).


